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Guide Information:

This guide aims to get you up and running using LUX Walker.

About:

Experience Architecture in Virtual Reality. LUX WALKER is an interactive PC and VR application that
instantly converts your 3D model into a fully immersive 3D true-to-life scale model. Compatible with
most 3D modelling software, one-click opens your 3D model as a .WALK file in LUX Walker.

LUX WALKER has been developed as a real-time visualization tool to improve workflow and reduce
communication errors. Join multiple people in a virtual building, collaborate with your team members
throughout design development and present your final design to clients, from anywhere in the world.

LUX Walker: 1
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2 LUX Walker:



CHAPTER 1

Instant VR

Note:

LUX Walker Instant 3D to VR Automated workflow tool. Convert your 3D model to VR, interact and collaborate.
Make faster design decisions, present your work.
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CHAPTER 2

Automated Workflow

Note:

LUX WALKER is meant to be as simple as possible. We Geolocate your model, carry across your layers, import
your cameras and views and we convert your texture maps to realistic digital materials.

This allows you to review your design quickly without worrying about model setup.

Because we keep all the complexities in the back of this simplified workfow, most of your work stays in your modeling
program. We offer support for many tools and with OBJ support you can export from the others.

5
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CHAPTER 3

Easy Collaboration

Note:

LUX WALKER has been developed as a real-time visualization tool to improve workflow and reduce communication errors.
Join multiple people in a virtual building, collaborate with your team members throughout design development
and present your final design to clients, from anywhere in the world.

Just send them .WALK export.

7
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CHAPTER 4

Typical Workflow

Typically LUX Walker is used like so:

4.1 Export your 3D Model

Note:

First, you need to export your 3D model so we can view it in LUX Walker. We have exporters for various 3D
tools, and support .OBJ files for advanced users.

9
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4.1.1 Exporting to LUX Walker

Plugins for various 3D tools export a .WALK file which can be opened in LUX Walker. See below for more information
using your favorite tool.

3Ds Max Export

Convert your 3ds Max model to a fully immersive true-to-life scale virtual reality model, instantly.

Note: Ensure that your materials are set to the default materials in 3Ds Studio Max. And that your export units result
in 1 Unit = 1 Meter. This might mean changing the global units in the file.

Project Information - 3Ds Max

Warning: Unfortunately we are not yet able to extract gps information from your 3Ds Max file.

Model Preparation - 3Ds Max

Note: Please make sure your model is as clean as possible to ensure best performance. When in doubt pro-optimize

Exporting a .WALK File

Note: The Exporter will export everything that is visible in the view. Please hide objects and layers that does not
require exporting.

1. Export from the File>Export Menu.

10 Chapter 4. Typical Workflow
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Export your file as an .OBJ

2. Select the high-lighted .OBJ Export options

4.1. Export your 3D Model 11
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Continue Here:

OBJ Export

Enjoy your WALK

.

FAQ - 3Ds Max

1. XXX:

xxx

2. XXX:

xxx

Blender .WALK Plugin

Instantly convert files from Blender to VR. Explore a fully immersive true-to-life scale model in LUX Walker.

Note: Please install the Export Plugin in order to export to .WALK files from Blender.

Step 1: Go to File>User Preferences in Blender.

12 Chapter 4. Typical Workflow



LUX Walker, Release 1.5.x.x

Step 2: Select Add-ons and click on Install from File. . . .

4.1. Export your 3D Model 13
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Step 3: Navigate to C:ProgramDataTenebris LabPluginsBlenderand select the io_export_LUXWALKER.py file.

Step 4: Enable the .WALK Add-on

14 Chapter 4. Typical Workflow
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You are now ready to export to LUX Walker.

Project Information - Blender

Warning: Unfortunately we are not yet able to extract gps information from your blender file.

Model Preparation - Blender

Note: Please make sure your model is as clean as possible to ensure best performance.

Exporting a .WALK File

Note: The Exporter will export everything that is visible in the view. Please hide objects and layers that does not
require exporting.

1. Export from the File>Export Menu.

4.1. Export your 3D Model 15
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2. Find the .WALK file in the same folder as your Blend file.

3. Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.

Enjoy your WALK

.

16 Chapter 4. Typical Workflow



LUX Walker, Release 1.5.x.x

FAQ - Blender

1. XXX:

xxx

2. XXX:

xxx

Revit .WALK Addin

Our Revit plugin is compatible with Revit 2018-2020 and makes exporting your projects simple yet highly customiz-
able.

Project Information

Note: Your project location and project North will be imported along with any selected cameras.

Model Preparation

Note: Please make sure your model is as clean as possible to ensure best performance.

4.1. Export your 3D Model 17
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Content Preparation

Location and Model Info

Note: Lux Walker imports your location information from your Revit file. This allows for correct lighting and
seasonal conditions for your project.

To do this you need to correctly set up your projects location and project north within your Revit project.

1. In Revit Click: Manage tab>Project Location panel> Location.

2. In the Location Weather and Site dialog, click the Location tab.

3. Specify the project location using one of these methods:

• Default City List:

• Nearest major city. For City, select a city from the list.

The corresponding Latitude, Longitude, and Time Zone values are displayed.

Exact location. Enter values for Latitude and Longitude.

Internet Mapping Service: For Project Address, enter the street address, city and state, or latitude and longitude of the
project, and click Search.

Warning: Please ensure your True North is correctly set up so that sun angles are correct in LUX Walker.

18 Chapter 4. Typical Workflow
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Optimize your model

Note: When exporting to VR keep in mind that it needs to run as fast as possible so that the user does not experience
motion sickness. Too many digital lines and geometries will slow down the project.

• Hide elements and categories not required for discussion.

• Limit your view distance.

• Remove Complex Geometry and Unnecessary Detail.

• Create a section box around what you would like to showcase.

• Have a less detailed master plan

• Section box areas or parts of the project with more detail.

• Use objects and Vegetation from the LUX Walker Library.

4.1. Export your 3D Model 19
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Unnecessary Elements and Categories

Each category in Revit is exported as a Layer to LUX Walker. LUX Walker includes a library of items and entourage.

Note: Please disable items, families, categories and elements you do not need to see in VR.

Categories like: Massing, Entourage, Planting Can also be problematic, and can be replaced with LUX Walker items.

View Distance

Rendering distance has a massive impact on performance in LUX Walker. The panorama tool allows you to load in a
panorama which you can use to create realistic context for your buildings. LUX Walker can also import context model
around your site. Keep your projects and site extents as small as possible.

Note: If you absolutely need to load in a large 3D site model make sure you section box so your building is as close
to the centre as possible.

Warning: If you do not section box do this you might have problems finding your project when LUX Walker has
loaded.

20 Chapter 4. Typical Workflow
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Warning: Please ensure that your survey points and base points are correctly set up. If they are too far apart your
file will appear empty. In the above example the survey point was thousands of units away from the model center.

4.1. Export your 3D Model 21
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Complex Geometry and Detail

Warning: Small and highly detailed items can cause slowdowns and issues with rendering in VR

When in doubt or the project runs slowly switch to wireframe view in Revit and inspect the file for complex objects.
Anything that appears solid from a distance in wireframe mode can cause issues and slow downs. Use items from
LUX Walker library where possible.

Section Box and Model Variations

You can the create a section box to crop your export. LUX Walker will download a large terrain around your project
so use Revit topography sparingly or crop as close to project as needed.

4.1. Export your 3D Model 23
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Note: You can enable and disable linked files in your layer tool in LUX Walker. You can use this to your advantage
by: Linking in two different variations of a project into a new Revit Project and switching between them using the
layer panel.

24 Chapter 4. Typical Workflow
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Large Projects

When dealing with large projects with may units/structures/spaces to show export the project as different files.

4.1. Export your 3D Model 25
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Note:

We recommend making different exports:

1. Export a masterplan .WALK file without any furniture or details. Please make sure these elements are also
off in your Linked Revit Files.

2. Create detail section box models of rooms or parts of the building.

This allows you to explore and discuss the project at various scales instead of focusing on micro details when macro
elements are being discussed.

Items and Vegetation

Using LUX Walker detail items and vegetation will increase performance and make the experience faster
and more realistic.

Note:

CAD imports and Complex Items in Revit are problematic. Items like: Pillows, 3D Fire and smooth furniture
items and CAD cars will cause slowdowns.

Note:

LUX Walker’s library includes pillows, bottles, glasses, books, cars, plates and vases and many more. These
items have been added to the library to reduce the impact on performance and give the user a better experience
in VR.

26 Chapter 4. Typical Workflow
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Material Transfer

Note: Textures assigned to the Generic Slot in Revit will be exported along with color and transparency information.

4.1. Export your 3D Model 27



LUX Walker, Release 1.5.x.x

Warning: If Use Render appearance is unchecked Color will be exported from here.

Note:

LUX Walker will automatically convert your Revit materials to something more realistic. Keep in mind that all
your settings will transfer including tint and fade settings. This means if you fade a material so it looks better in
a Revit view it will come in as transparent in LUX Walker.

Common Issues

LUX Walker is slow: Reduce geometry quality using the quality slider. Remove unused details and objects from the
export view.

Note: You can usually tell by the .WALK file whether it will be slow. Files over 200MB quickly get very slow.

Materials are not correct in LUX Walker: Ensure the material settings are correct in Revit. Materials with fade
and tint will export these settings to LUX Walker.

28 Chapter 4. Typical Workflow
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Note: If you have told Revit to use render appearance then the render appearance will be exported to LUX Walker.
Please also inspect your fade and color assignments as they also carry over.

Export Process

Note: The Exporter will export anything that is visible in the view. Please disable anything that does not require
discussion.

Exporting Steps

1. Open a project in Revit that you wish to export for VR Walkthrough.

2. Open The Default 3D View OR Choose an existing 3D View

3. Select the Add-Ins tab inside of Revit.

4. Click the Export Lux Walker button on the Tenebris Lab section.

4.1. Export your 3D Model 29
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5. Click Change to change the location of the export.

6. Type in the File Name for your project, then click Export to start the export process.

30 Chapter 4. Typical Workflow



LUX Walker, Release 1.5.x.x

10. Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.

Enjoy your WALK

4.1. Export your 3D Model 31
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Export Window Settings

Add Date:

Appends a date to your filename for easy versioning.

Export Quality

This limits the amount of geometry exported to LUX Walker. A value of 6 is generally good enough for VR. Higher
values will mean LUX Walker will be slower. Optimize

Views to Export

This allows you to choose camera views to export to LUX Walker for quicker navigation in the Render tool.

Optimized Export

Optimizes your file. Might increase loading time, but greatly improves comfort in LUX Walker. Has been removed in
newest exporter.

Run in LUX Walker

If LUX Walker is installed on your PC this will open the file after exporting.
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Versioning

Export a new file or use the “Add Date” export option to create versions of a project. Please note: You cannot use
multi user walk through mode with different versions of a project.

Design Options

Create a new Master File. Link in Option 1 and Option 2. In LUX Walker use the layer tool to disable and enable
design options.

Optimize

Note: LUX Walker can optimize your export by lowering the value in the Export Quality slider.

This reduces geometry count which in turn speeds up LUX Walker. It has some side effects such as reducing the edges
of round objects making them appear more geometric in shape. If you absolutely need to see something at the highest
detail, export a “section box” of only the items/room in question and increase the slider to the maximum value.

For Large projects we recommend exporting the whole project at 5 or below, then exporting section boxes of areas
within the project at a higher quality.

This adds the benefit of limiting discussion around a specific part of a project and not getting lost in undeveloped areas.

FAQ - Revit

Note: LUX Walker is slow:

Reduce geometry quality using the quality slider. and Remove unused details and objects from the export view.

Note: Material Transfer:

Materials are not correct in LUX Walker. Ensure the material settings are correct in Revit. Materials with fade and
tint will export these settings to LUX Walker.

4.1. Export your 3D Model 33
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Rhino .WALK Plugin

Rhino to VR. Instantly convert your Rhino model in to a fully immersive true-to-life scale design model, with LUX
Walker.

Note: First you need to install the plugin for Rhino.

1. Download the Latest Rhino plugin from here.

2. Double click the downloaded file (Export To LUX Walker.rhi) to install the Plugin to export to LUX Walker.

You might have to reload Rhino if it was open during installation of the plugin.

Project Information - Rhino

Setting up the Sun correctly in Rhino ensures correct location info is transferred to LUX Walker.

Note: Go to the pulldown menu Panels and open the Sun panel

This will give you access to the correct simulation of the sun position

34 Chapter 4. Typical Workflow
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In the sun menu:

1. The sun option has to be activated

2. The North direction has to be set to your offset, if any, in degrees. This will orient the north correctly with your
scene

4.1. Export your 3D Model 35
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3. The last setting is the location. The nearest location can be selected from the list or by clicking Here the location
is set based on the location of the laptop. With these settings the sun will be positioned correctly in LUX Walker.

Model Preparation - Rhino

Please make sure your model is as clean as possible to ensure best performance.

Exporting a .WALK File

Note: The Exporter will export everything that is visible in the view. Please hide objects and layers that does not
require exporting.

36 Chapter 4. Typical Workflow
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1. Run the command LUXWALKER in Rhino.

Optionally enable the Tenebris Lab toolbar.

2. Find the .WALK file in the same folder as your Rhino file.

3. Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.

Enjoy your WALK

.

4.1. Export your 3D Model 37
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FAQ - Rhino

1. XXX:

xxx

2. XXX:

xxx

Sketchup .WALK Plugin

Our Sketchup plugin is compatible with Sketchup 2015-2019.

Note: You can export from any other version using the OBJ Export Method

Project Information - SKP

Note: Your project coordinates will be exported to LUX Walker as well as any views you have set up.
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Go to Window > Model Info > Geo-location and click Add Location

Ensure your project is orientated correctly in Sketchup if you want the correct context and shadows.

Model Preparation - SKP

Note: Please make sure your model is as clean as possible to ensure best performance.

4.1. Export your 3D Model 39
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You can right click on the toolbar area to enable the LUX Walker toolset.

Note: Correct layer management in Sketchup will ensure less issues down the road.
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Included in the toolset is a simple button to setup your project with correct layers.

You can then Right click on a group or component and Click LUX WALKER - Put On Layer > LAYER

This will put all object and geometry nested in the group or component onto the selected LAYER.

Note: Switch to wireframe mode and remove complex and small items.

4.1. Export your 3D Model 41
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Please disable items, groups, components and layers you do not need to see in VR. It is sometimes best to purge your
file before export. - Make a backup before purging.

LUX Walker includes a library of items and entourage that you can use in your projects.

Note: We recommend running Cleanup 3 for Sketchup. to clean unnecessary items. It has built in purge functionality.

Exporting a .WALK File

Note: The Exporter will export everything that is visible in the view. Please hide objects and layers that does not
require exporting.

1. Open a Sketchup project that you wish to export for VR Walkthrough.

2. Enable the Tenebris Lab Plugins to export to LUX Walker.

42 Chapter 4. Typical Workflow
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3. Save your file and Click the Export Lux button on the Tenebris Lab section.

4. Choose a folder you wish to export your .WALK file into.

4.1. Export your 3D Model 43
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5. Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.

Enjoy your WALK

44 Chapter 4. Typical Workflow
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FAQ - SKP

1. It is taking forever to export my file:

Sketchup does not like complex geometry. Please cleanup your model and removed unused items. We
recommend running Cleanup 3 for Sketchup. to clean unnecessary items

OBJ Export

LUX Walker is compatible with .OBJ files exported from your favorite 3D modeling software. We have imported files
successfully from: Archicad Cinema4d 3Ds Max Blender Sketchup

Project Information - OBJ

Unfortunately we are not yet able to automatically insert gps information into your file. Please import your model into
Sketchup or Revit and export from there to have accurate gps locations.

Note: Need Help?

Contact us if you know how to edit an ini file. . .

Model Preparation - OBJ

Please make sure your model is as clean as possible with the least amount of geometry you can show to ensure best
performance.

Note: You may be able to load much larger files if you split your model into more exported files - by category perhaps.
Smooth and round objects will cause issues. If possible reduce triangle count as much as possible.

Creating a .WALK File

Step 1: Create a folder and export your .OBJ to this folder. Make sure all textures are in a folder.

Note: You can have multiple .OBJ and .MTL files from different modelling programs as long as they all share the
same origin and scale.

Step 2: Open “LUX Home” click on the + icon

4.1. Export your 3D Model 45
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Step 3: Drag the folder containing the .OBJ to LUX Home.

Step 4: A .WALK file will be generated next to your export folder.
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3. Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.

Enjoy your WALK

4.2 Run LUX Walker

Note:

Second, you need to load this export into LUX Walker. LUX Walker will load most files, but VR has a limit to the
amount of geometry you can run smoothly. Contact Support if you have any problems.

4.2.1 Quick Start

Note: We recommend following the Tutorial available from the Home scene in LUX Walker.

4.2. Run LUX Walker 47
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Home

1. Select and choose project to load. (.WALK Files) – Opens file browser.

2. Click to enable multi user experience. See Multiplayer settings below.

3. Click to launch in VR.

4. Choose help to access tutorial and other options.

Note: The Tutorial will guide you in using LUX Walker and its Menu, but will not expose you to all tools.
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Using your VR Controllers

LUX Walker offers an intuitive help system and menu panel. Review the tools and help features that can be found
when using LUX Walker application.

4.2.2 Step into VR

Included from the LUX Walker home scene is a Tutorial level which will get you familiar with the LUX Walker
interface and using its tools in VR. For your convenience the tools and features are listed below

4.2. Run LUX Walker 49
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Mini Model

View a scale model of your project. Teleport to any location on the map. Simply point and aim the controller at the
desired location while holding down on the touchpad button. The teleport indicator will appear now release the button
to teleport to that location.

When in Mini Model you can squeeze both grip buttons and move both controllers apart to zoom in or move them
together to zoom out. You can also rotate the model like this.

Use one grip and controller to move the model.

50 Chapter 4. Typical Workflow
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Time Tool

1. Time Tool Icon — Click on this icon to access the time tool and the settings for the time tool.

2. Change the time of day with the suns correct geolocation. Drag the sliders handle icon left or right to change
the time of day.

3. Select a custom date from the calendar.

4. Tabs can be used to select a season.

5. Displays the geolocation in the world.

4.2. Run LUX Walker 51
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Layer Tool

1. Layers Tool Icon — Click on this icon to access the layers for the project.

2. Manage Layers Window — Access all the layers and show and hide them by clicking on the yellow box on the
left hand side of the layer.

3. Show/Hide all layers — The top icon activates all layers, while the bottom icon de-activates the layers.

Environment Tool

XXXXXX

Panorama Tool

XXXXXX
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Render Tool

1. Zoom — Use this slider to adjust how zoomed the view for your render is. Alternatively, use the touchpad in
your non-laser hand to zoom in and out.

2. Time of day — Slide to change the time of day.

3. Presets — Contains a list of your preset camera settings.

4. Saturation/Contrast and Temperature/Exposure — Move this icon across your viewer to adjust the satura-
tion/contrast and temperature/exposure of your view.

5. Settings — Clicking on this icon will open a menu containing resolution and quality settings.

6. Add Preset — Use this button to add a preset with current camera settings.

7. Filter Amount Slider — Use this slider to adjust how much the filter applies to the view

8. Grid Mode — Toggles a grid over your view.

9. Panorama Mode — Sets the view to panorama mode which will render a 360 image while active.

10. Filter Toggle — Toggles if the filter is active or not.

11. Filter List — Shows a list of the filters.
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Placement Tool

1. Placement Tool Icon — Click on this icon to access the placement tool and the settings for the placement tool.

2. Navigation Tabs — Use this to navigate between different tabs for various object types.

3. Displays the current selected object.

4. Toggles multiple placement on/off.

5. Toggle upright snap on/off when placing objects.

6. Toggles random scale on/off for the current selected object.

7. Toggles between placement and deletion of placed objects.

Material Tool

XXXXXX
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Annotation Tool

1. Annotation Tool Icon — Click on this icon to access the annotation tool and the settings for the annotation tool.

2. Distance Draw — Click on this icon to toggle distance draw on or off. If distance draw is off the annotation will
not snap to objects.

3. Layer Controls — use these buttons to clear or delete the corresponding layer.

4. Layers — Select a layer to start making annotations on that layer.

5. Assign and draw modes — Select the Assign icon to assign drawings to the selected layer and switch back to
the draw mode to create drawings on the currently selected layer.
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Measure Tool

1. Measure Tool Icon — Click on this icon to access the measure tool and the settings for the measure tool.

2. Used to select a measure mode, this will influence the direction the measurement tool will measure in.

3. Use the drop down box to select the unit you wish to measure in.

4. Displays the measurement mode that is being used.

5. The visual reference of the distance measured.

6. Displays the distance between two surfaces.

4.2.3 Share a .WALK Project

Note: As long as another user has LUX Walker you can share a file with them and step into the same world.

How To Multi-user LUX Walker walkthrough:

1. Export your .WALK.
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2. Test your file in LUX Walker.

3. Send the .WALK file to your collaborator – they need a copy of LUX Walker.

4. Open the file on either PC’s.

5. Enable Multi-User Mode.

6. Click VR Mode icon.

7. Open the file on the other PC.

8. Enable Multi-User Mode.

9. Click VR Mode icon.

4.3 Fix any Materials

Note:

Our conversion process aims to generate realistic materials from your provided materials and texture maps.
In some cases this might result in incorrect materials. Our Material tool allows you to easily switch between
various types of materials or choose from a growing library of built in materials.

4.4 Highlight any issues

Note: We offer Markup and Measurement tools

DRAW TOOL

4.5 Add Context or Panorama

Note:

Context Immediately makes a project more immersive and can help solve problems earlier in the design process.
You can add context using the Terrain Toggle in the Environment Tool. Or add a panorama to the project using
the Panorama Tool

PANORAMA TOOL GOES HERE
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4.6 Add Vegetation and detail items.

Warning:

Complex 3D items will slow down your VR Experience. LUX Walker includes a large library of detail items
and vegetation. Use these wherever possible.

VEGETATION AND ITEMS HERE

4.7 Save your File

using/images/lw_save.jpg

Note:

Closing LUX Walker will ask you if you want to Save your File. You can also save from the Menu Panel in VR or
by clicking the Home Button on the desktop using the Mouse.

using/images/lw_save_alt.jpg

4.8 Capture some Images

Note: Images of up to 4K can be saved.

RENDER TOOL

SAVE FILE
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4.9 Relink a new Export

Note: Keep LUX Walker changes and Reload a new Model

This allows you to Merge data from an old file using LUX Home.

4.10 Share a File

Send a .WALK file to collaborators
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System Requirements and Installation

More Info:

See below for more system requirements and Installation instructions.

5.1 Virtual Reality

Note: Our software is aimed at users with a VR Headset and motion controllers. It is compatible with both Oculus
and Steam VR Devices.

5.1.1 Choosing your VR Headset

If you are going to use LUX Walker in Virtual Reality (VR) Mode, you will need a VR Headset - Head Mounted
Display (HMD).
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For users who want to set up multiple users in the same room or want full room-scale virtual reality we recommend
the HTC Vive, users who work alone at a desk or who want portability can use an Oculus Rift. Both are great devices
and have advantages over another.

HTC Vive and Steam VR

The HTC Vive and the Valve Index is the best choice for users who want standing, room-scale virtual reality. Offering
much larger play space than the competitors.

Detailed product info here.

It is also the only way to get accurate multiple person tracking spaces.

We suggest wall mounting your HTC Vive base stations for the best experience or, for portable setups, mount them on
tripods or light stands.

Running the HTC Vive requires a computer with powerful graphics capabilities. Refer to our recommended specs to
see if you need to upgrade your computer.

Oculus Rift

The Oculus Rift is a great choice for people who want to use VR at their desk or on the go. It is quick to set up and
very comfortable to use. However it requires 3 USB 3 Ports.

The Oculus Rift S is even easier as it does not require any extra sensors and only one USB 3 port.

Detailed product info here.

Running the Oculus Rift requires a computer with powerful graphics capabilities. Refer to our System Requirements

5.2 System Requirements

Note: Our software is aimed at users with a VR Headset and motion controllers. It is compatible with both Oculus
and Steam VR Devices.

Virtual Reality requires a high-end computer aimed at rendering 3D computer graphics as fast as possible. If
at anytime the experience is slow it will cause motion sickness and an uncomfortable experience in VR.

Warning: Please note even the most powerful machine will not run a badly optimized 3D model. Please follow
our modeling guidelines outlined in the documentation.

Both Oculus and Valve have recommended system requirements that will work with many smaller projects. For larger
projects with more materials and for an overall better experience the requirements are a little higher.

See below for Minimum and Recommended system requirements. For more information see budget section below on
choosing the right pc and its importance on rendering speed.

5.2.1 Minimum Requirements:

Note:
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• OS 64-bit Windows 7, Windows 8.1, Windows 10

• PROCESSOR Intel i5 5th Gen (or equivalent)

• MEMORY 8GB

• GRAPHICS NVIDIA GeForce GTX 970 4GB+ (or equivalent)

• DIRECTX Version 11

• STORAGE 5GB available space

5.2.2 Recommended Requirements:

Note:

• OS 64-bit Windows 7, Windows 8.1, Windows 10

• PROCESSOR Intel i7 6th Gen (or equivalent)

• MEMORY 16GB

• GRAPHICS NVIDIA GeForce GTX 980 8GB (or equivalent)

• DIRECTX Version 11

• STORAGE 5GB available space

5.3 Installation

1. Go to https://www.tenebrislab.com/my-account and download LUX WALKER.

2. Once downloaded, double click on the .exe to begin the installation process.
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CHAPTER 6

Exporting

More Info:

See below for more information exporting from your favorite 3D tool.
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CHAPTER 7

Using LUX Walker

More Info:

See below for more information on using LUX Walker.

7.1 LUX Walker Settings

Some settings are only accessible using the mouse on the desktop.
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7.1.1 Settings Panel
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7.1.2 Quality Options

1. Quality Settings

Graphics Quality - Increases sharpness of objects at an increase to performance cost. Vegetation Quality
- Increases vegetation rendering distance at an increase to performance cost. Advanced settings

Render Scale - Manually Increase sharpness of objects at an increase to performance cost.
Shadow Quality - Manually Increase shadow quality at an increase to performance cost.

2. Lighting Settings

Global Light - Increase or decrease the environmental light contribution in the scene.

Advanced settings

Sampling Size - Increases the lighting contribution size at an increase to performance
cost. Sampling Size - Increases the lighting area that gets realistic lighting at an
increase to performance cost. Lighting Samples - Increases lighting quality at an
increase to performance cost.

3. Render Settings

Screenshot Size - Size of the Images captured by the spectator render camera. Render Mode - Quality of
the Render Mode spectator camera.
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7.1.3 Panorama

LUX Walker allows you to load a panorama as onto a cylinder that renders behind other objects.

1. Offset - Height offset from Horizon

2. Radius - Radius of the Cylinder that holds the panorama.

3. Rotation - Rotation of the Cylinder that holds the panorama.

4. Scale - Scale of the Cylinder height that holds the panorama.

5. Load Image - Load Panorama from hard drive.

Note: Combinations of Radius and Scale will allow you to get correct aspect ratios.

Removing the background in an image editing program and saving as a .PNG will blend the panorama with the
background.

7.1.4 Multiplayer

1. Lock Teleport - Sync teleport across networked users

2. Lock Time - Sync time across networked users

3. Room ID - Room information

7.2 LUX Home

Manage projects with a view of your recent files in LUX Home.
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7.2.1 Overview

1. Projects Tab

2. Import/Link Tab

3. Merge Tab

4. Refresh Project Library

5. Open Lux Walker

6. Open Lux Navigate

7. Settings Tab

8. Open TenebrisLab.com
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7.2.2 Projects Tab

View all your exported projects, select a project and open it in Lux Walker or open renders in Lux Navigate.

1. Project Paths – Shows where the project files are located. Click to open folder in File Browser

2. Version Selector – Choose which exported version of the project you would like to open

3. Remove Project from Library. No files will be deleted.

7.2. LUX Home 73



LUX Walker, Release 1.5.x.x

7.2.3 Link Tab

Allows dragging and dropping a folder to convert it to a .WALK file. The folder needs .obj and .mtl files inside, as
well as a folder containing your textures.

You can also drag in a .WALK file to add it to your library. This allows you to add projects located on a network drive,
that may have been exported by someone else.
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7.2.4 Merge Tab

Allows you to merge files between two .WALK files. If you have cameras, markup or vegetation in a project and you
would like to add it to an updated export of the project you can use this tab to merge items between projects.

1. Browse for the project file that contains the items you would like to add to another project.

2. The project name and location will autofill once a project file is selected.

3. Check which items you would like to be merged.

4. Select the target project to which you wish to add the selected items.

5. Click to commit merge and copy items to project.
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7.2.5 Settings Tab

Manages the linking between the various Lux Suite programs and Lux Home. Used to re-establish the links if they
were lost.

1. The current path to the selected program.

2. Click to change the location of the selected program.
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CHAPTER 8

Contact and Support

8.1 FAQ

1. Test

2. Test2

3. Test3

4. Test4

8.2 Troubleshooting

8.2.1 Network Related Issues

Note: LUX Walker requires that you open TCP port 843 for multiplayer networking.

If you are experiencing any other issues you can try open the following ports.

TCP: 4530 4531 4533 9090 9091 9093

UP: 5055 5056 5057 5058

Fore more information see here: https://doc.photonengine.com/en-us/server/v3/reference/tcp-and-udp-port-numbers

8.2.2 License Issues

Stuck Linked License:

1. Open LUX Walker on PC with linked license.
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2. Wait for Home Screen.

3. Close LUX Walker

Unable to Register

1. Check Internet connection.

2. Restart PC.

8.3 Need Help?

If you have any further Questions, please contact support@tenebrislab.com

8.4 EULA

END-USER LICENSE AGREEMENT FOR TENEBRIS LAB (PTY) LTD

This End-User License Agreement (EULA) is a legal agreement between you (either an individual or a single entity)
and the mentioned author (Tenebris Lab (Pty) Ltd) for the Tenebris Lab software that accompanies this EULA, which
includes computer software and may include associated media, printed materials, and “online” or electronic documen-
tation (“Software”). By installing, copying, or otherwise using the Software, you agree to be bounded by the terms of
this EULA. If you do not agree to the terms of this EULA, do not install or use the Software.

DEFINITIONS:

Tenebris Lab is the Author of the Software. LUX SUITE is a package comprising of LUX WALKER and LUX NAV-
IGATE. Latest versions of our software can and should always be downloaded from https://www.tenebrislab.com/
my-account/ LUX “.VIEW, .NVGT and .WALK” Projects are file-types used by LUX WALKER and LUX NAVI-
GATE.

GRANT OF LICENSE:

This License allows you to: Install and use LUX WALKER on multiple computers and make copies of LUX WALKER
in Machine-readable form for backup purposes, provided the number of concurrent users does not exceed the number
of LUX WALKER licenses purchased. You must reproduce on any such copies all copyright notices and any other
proprietary legends on the original copy of LUX WALKER. A copy of LUX WALKER must be purchased for each
user. Provide a copy of LUX WALKER to people outside your company in order to use the collaboration tools
and viewing functions provided that the number of concurrent users does not exceed the number of LUX WALKER
licenses owned. Make copies of a LUX “.VIEW, .NVGT and . WALK” Projects, and distribute those copies for use
by yourself, personnel employed by you, clients, or another party.

LICENSE RESTRICTIONS:

Other than as set forth under “Grant of License”, you may not make or distribute copies of LUX WALKER, or
electronically transfer LUX WALKER from one computer to another or over a network. You may not rent, lease
or sublicense LUX WALKER. You may not modify LUX WALKER or create derivative works based upon LUX
WALKER.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS:

Limitations on Reverse Engineering, Decompilation, Disassembly and change (add, delete or modify) the resources in
the compiled the assembly. You may not reverse engineer, decompile, or disassemble the LUX WALKER, except and
only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.

HARDWARE REQUIREMENTS:
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You are responsible for obtaining and supplying the hardware necessary to run LUX WALKER, and Licensor has no
obligation to provide any hardware or support service for hardware. LUX WALKER runs on a Windows operating
system and needs internet access over HTTP to the license server of Tenebris Lab to run the professional version.
You shall be responsible for selecting the right resources required and for ensuring that these are available in full
and in a timely manner. Tenebris Lab shall under no circumstances be liable for losses or costs arising as a result of
transmission errors, breakdowns or the non-availability of these facilities. To see the hardware requirements please
visit https://tenebrislab.com/documentation/hardware/specs/

UPDATE AND MAINTENANCE:

Tenebris Lab regularly releases updates and adds new features to LUX WALKER. Any major new feature may be
liable to additional cost in the form of an upgrade or additional monthly fee.

PRIVACY:

By installing this copy of LUX WALKER you accept that LUX WALKER sends basic information like computer
name and hardware specifications to Tenebris Lab servers with the purpose to verify use of your license. By installing
this copy of LUX WALKER you accept that LUX WALKER sends test results and hardware specifications to Tenebris
Lab servers with the purpose to further improve future developments of our Software. This information will be used to
create estimates of performance of different hardware and to improve hardware compatibility. LUX WALKER uses a
floating license system and licenses are activated/de-activated on the Tenebris Lab license servers. In order to maintain
the activation status of LUX WALKER licenses (active or inactive), Tenebris Lab stores activation/de-activation data
in a database. Tenebris Lab also reserves the right to use this data for analytical purposes, such as usage statistics.

COPYRIGHT AND OWNERSHIP:

All title and copyrights in and to LUX WALKER (including but not limited to any images, libraries, and examples
incorporated into LUX WALKER ), and any copies of the LUX WALKER are owned by Tenebris Lab. The LUX
WALKER is protected by copyright laws and international treaty provisions. Therefore, you must treat the LUX
WALKER like any other copyrighted material. The licensed users or licensed company can use all functions, libraries
and symbols in the LUX WALKER to create new content and digital worlds.

BILLING: RECURRING BILLING:

By starting a paid subscription package of LUX WALKER, LUX NAVIGATE or the LUX SUITE and providing
a Payment Method, you authorize Tenebris Lab to charge you a subscription fee at the then current rate, and any
other charges that may arise in connection with your use of Tenebris Lab Software to your Payment Method. You
acknowledge that the amount billed each period may vary for reasons that may include promotional offers, and/or
changing a plan, and you authorize Tenebris Lab to charge your Payment Method for such varying amounts, which
may be billed in one or more charges. Tenebris Lab may change the pricing of its Software or components thereof in
any way and at any time as Tenebris Lab may determine in our sole and absolute discretion. Tenebris Lab will provide
notice via email or within Tenebris Lab software before any such price changes. If you do not wish to continue your
subscription you may cancel in accordance to Termination provisions below.

BILLING CYCLE:

The subscription fee for the Tenebris Lab Software will be billed at the beginning of your paid subscription period and
each month thereafter, unless and until you cancel your subscription or are still within the trial period. Tenebris Lab
automatically bills your Payment Method each period on the calendar day corresponding to the to the commencement
of your paid subscription. Tenebris Lab reserves the right to change the timing of our billing as indicated below if
your Payment Method has not successfully settled. In the event your paid subscription began on a day not contained
in a given month or year, Tenebris Lab will bill your Payment Method on an alternative day in the applicable month
or year as Tenebris Labs deems appropriate. For example, if you started a paid monthly subscription on January 31st,
your next payment date is likely to be February 28th, and your Payment Method would be billed on that date. Tenebris
Lab may authorize your Payment Method in anticipation of subscription or other changes. As used in this Agreement,
“billing” shall indicate a charge, debit or other payment clearance, as applicable, against your Payment Method.

REFUNDS:

Payments are NONREFUNDABLE and there are NO refunds for partally used billing cycles.
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TAXES:

You shall be responsible for paying all applicable sales, use, transfer, or other taxes and all duties, whether national,
state, or local, however designated, that are levied or imposed by reason of your paid use of the Software under this
Agreement, excluding income taxes on the net profits of Tenebris Lab. You shall reimburse Tenebris Lab for the
amount of any such taxes or duties paid or incurred directly by Tenebris Lab as a result of such paid use, and you
agree that Tenebris Lab may charge any such reimbursable taxes to your Payment Method. Payment Methods: You
may edit your Payment Method information by signing in to your account at https://tenebrislab.com/my-account/. If
a payment is not successfully settled, due to expiration, insufficient funds, or otherwise, and you do not edit your
Payment Method information or downgrade or cancel your subscription, you remain responsible for any uncollected
amounts and authorize Tenebris Lab to continue billing the Payment Method, as it may be updated. This may result in
a change to your payment billing dates. For certain Payment Methods, the issuer of your Payment Method may charge
you a foreign transaction fee or other charges. Check with your Payment Method service provider for details.

TERMINATION:

Termination by Tenebris Lab: Without prejudice to any other rights, the Tenebris Lab may terminate this EULA if
you fail to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the
Tenebris Lab Software and all of its component parts. We, the Licensor reserves the right to terminate the service of
subscription and will provide a 2 month notice to the Licensee regarding such termination. Termination by You: If at
any time you want to cancel your subscription you may do so by visiting https://tenebrislab.com/my-account/. If you
cancel your subscriptions, you have no further payment obligations to Tenebris Lab, but your usage rights and access
to Tenebris Lab Software will be revoked. Your account will still be active on Tenebris Lab website and will not be
removed unless you email support@tenebrislab.com and request full deletion of your account..

NO WARRANTIES:

Tenebris Lab expressly disclaims any warranty for Tenerbris Lab Software. The LUX WALKER and any related docu-
mentation is provided “as is” without warranty of any kind, either express or implied, including, without limitation, the
implied warranties or merchantability, fitness for a particular purpose, or non-infringement. The entire risk arising out
of use or performance of Tenerbris Lab Software remains with you. NO LIABILITY FOR DAMAGES: In no event
shall the Tenebris Lab be liable for any special, consequential, incidental or indirect damages whatsoever (including,
without limitation, damages for loss of business profits, business interruption, loss of business information, physical
or emotional harm caused as a result of the software, or any other pecuniary loss) arising out of the use of or inability
to use this product, even if Tenebris Lab is aware of the possibility of such damages and known defects.
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